Global Power & Propulsion
TECHNICAL CONFERENCE
2023
October 17-19
HONG KONG, CHINA
+ CFD Workshop
October 16
The promise of 2050, when the Power is Clean and Global Travel is Electrifying.
Welcome to GPPS Hong Kong23

On behalf of the organizing committee, I have the great pleasure of welcoming you all to the Global Power and Propulsion Society (GPPS) Technical Conference Hong Kong 2023. GPPS is a global platform for researchers, engineers, and industrial and academic leaders to convene and shape the future of our profession. Its emphasis on the fusion of industry and academia is a cherished tradition that the Hong Kong conference aims to inherit and amplify. This conference takes place against the backdrop of rapidly growing global climate challenges and other world events that hinder our efforts to collectively address these issues. I hope that Hong Kong, Asia’s World City, will be the place where we rekindle the collaborative spirit between the East and the West, North and South. The city is home to several well-known universities, and our conference is hosted in the HKU Main Building, the oldest structure in the first university here.

When we selected keynote speech topics, we made efforts to step out of our comfort zone to embrace emerging directions, such as the space solar power plant that beams down energy via microwaves, fusion power, AI, and quantum algorithm as a design tool, etc. This was done with full attention to our core task of developing economical and practical decarbonization technologies at this point in time.

In the 1+3-day program, you will also find numerous social networking opportunities. As was done in Chania, Greece, last year, we begin with the CFD workshop on Monday. There will be an opening reception on Tuesday evening in the Loke Yew Hall, where all plenary talks are given. We very much hope that participants will meet new and old friends and freely explore dinner options outside the campus following the reception. However, for female participants, we have a “Women in Power and Propulsion Sectors” special dinner gathering following the reception drink. On Wednesday evening, we will board a beautiful cruise ship to enjoy Victoria Harbour with unlimited drinks, supplemented by delicious food. Please note that the sailing may have to be canceled by legal requirements in the unfortunate event of a typhoon with excessive vorticity, but reasonable risk-takers like us will fully enjoy the night whenever the weather allows. Lunch breaks will take place in the Loke Yew Hall, and coffee will be served both in the hall and the Convocation Room on the 2/F, where exhibits from our generous sponsors will be held. Parallel sessions will be held on the 1st and 2nd Floors. The closing ceremony will be held back in the hall on Thursday afternoon when the winners of the student paper competition will be announced.

If you need any assistance with local knowledge or ideas for places to visit after the conference, please do not hesitate to approach me, student volunteers, or our administrative colleagues. We hope you will thoroughly enjoy this week in Hong Kong.

Professor Lixi Huang
GPPS Hong Kong23 Conference Chair
Join us at the upcoming GPPS Forum24, our flagship event taking place in Zurich on January 17th - 18th, 2024.

GPPS Forum24 is dedicated to addressing the critical transition towards decarbonized energy supply and sustainable air travel. Our focus will be on a regional perspective as we look ahead to achieve NET ZERO with an energy supply that’s both affordable and secure. The pace of this journey will be influenced by economic considerations and the enabling technologies of the next decades.

At the Forum, we will explore both current and future technologies, providing insights into their deployment potential. Additionally, we will delve into the financial aspects of this transition and highlight mechanisms to support it.

This event is an exceptional networking opportunity, allowing you to connect with fellow professionals from the energy and propulsion industry on a personal level. Join us for a series of engaging social networking events.

We’re excited to welcome you to GPPS Forum24 as we collectively shape the future of sustainable energy and air travel. Register today and be part of this experience!

For more information regarding GPPS Forum24 please visit: www.gpps.global/gpps-energy-forum24

<table>
<thead>
<tr>
<th>Welcome to GPPS Hong Kong23</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networking &amp; Registration</td>
<td>5</td>
</tr>
<tr>
<td>Campus Area Map</td>
<td>6</td>
</tr>
<tr>
<td>Technical Conference: Floor Plans</td>
<td>7</td>
</tr>
<tr>
<td>CFD Workshop</td>
<td>8</td>
</tr>
<tr>
<td>Conference Schedule Overview</td>
<td>9</td>
</tr>
<tr>
<td>Organizing Committees</td>
<td>10</td>
</tr>
<tr>
<td>Sponsors</td>
<td>12</td>
</tr>
<tr>
<td>Keynote Speakers</td>
<td>14</td>
</tr>
<tr>
<td>Conference Paper Sessions</td>
<td>16</td>
</tr>
<tr>
<td>Track Chairs</td>
<td>17</td>
</tr>
<tr>
<td>Presenting Authors</td>
<td>18</td>
</tr>
<tr>
<td>Detailed Schedule</td>
<td>20</td>
</tr>
<tr>
<td>Tuesday</td>
<td>20</td>
</tr>
<tr>
<td>Wednesday</td>
<td>27</td>
</tr>
<tr>
<td>Thursday</td>
<td>37</td>
</tr>
<tr>
<td>Author Index</td>
<td>45</td>
</tr>
</tbody>
</table>
Networking & Registration

Registration Location

CFD Workshop Registration (see map page 6)
Monday, October 16th
08:00 - 18:00 Library Extension, Foyer of Room 1 (LE1, also called the Hui Pun Hing Lecture Hall) [R1 on map, page 6]

Conference Pre-Registration (see map page 6)
Monday, October 16th
09:00 - 18:00 Library Extension, Foyer of Room 1 (LE1, also called the Hui Pun Hing Lecture Hall) [R1 on map, page 6]

Conference Registration Location (see map page 7)
Tuesday, October 17th
07:45 - 18:00 Foyer of Loke Yew Hall, 1st Floor [R3 on map]

Wednesday, October 18th
09:00 - 18:00 Foyer of Loke Yew Hall, 1st Floor [R3 on map]

Thursday, October 19th
09:00 - 18:00 Foyer of Loke Yew Hall, 1st Floor [R3 on map]

WIFI Access
Internet access is available within the conference area.

To login please use:
WLAN: Wi-Fi.HK via HKU
Password: None required

Registrants will be provided
→ Name badge and welcome package
→ Access to every session in registered event
→ Data for all of the final papers of GPPS Hong Kong23
→ Access to all coffee breaks, lunches, opening reception and harbour cruise (all with the name badge)
Lost your name badge? Go to the Registration Desk to obtain a replacement.

Networking Events

Opening Reception
Tuesday, 17th October, 18:00-19:30-
Location: The Loke Yew Hall.

Coffee & Networking
October 17th - October 19th
Location: The Loke Yew Hall [R2 on map].
+ Convocation Room (MB 218) [R4 on map].

Daily Lunches
On Monday, participants can have sandwiches provided or use campus canteen (ask student helpers for direction).

Tuesday, October 17th, 12:25 - 13:25
Wednesday, October 18th, 12:40 - 13:40
Thursday, October 19th, 12:15 - 13:15

Lunch boxes will be available in the Loke Yew Hall with limited seats/desks. The convocation room (MB218) and the two rooms opposite the hall, MB103 & MB167, will also be open for having lunch. Please take extra care to minimize litter in the hall and the classrooms.

Harbour Cruise (and Event Dinner)
Wednesday October 18th, 19:00 - 21:00
Dress code: Business casual
Meeting Point in front of the Main Building @ 18:10

Harbour Cruise & Dinner
Enjoy exquisite culinary delights and beverages aboard the elegant Oriental Pearl cruise ship, all while immersing yourself in the breathtaking sights and dazzling lights of Hong Kong during the evening hours.
Meeting Point: 18:10 in front of Main Building
Campus Area Map

GPPS CFD Workshop:
Library Extension, Room 1 (LE1, also called the Hui Pun Hing Lecture Hall)
GPPS Technical Conference:
Loke Yew Hall, HKU Main Building
Pok Fu Lam Road, Hong Kong

Walking route from metro station (MTR, exit A1) to Loke Yew Hall
Walking route from metro station (MTR, exit A2), take lift to the Upper Level of University Street to CFD Workshop R1
Alternative walking route from metro station (MTR, exit A1), to CFD Workshop R1
TAXI INSTRUCTIONS
Please take me to the University of Hong Kong on the Hong Kong Island, Pokfulam Road via West Gate, I’d like to alight near the main building

The taxi fare from the Airport to the University is 350-500 HKD by cash payment.

For further information on accommodation and transportation in this area please visit our website here: www.gpps.global/accommodation-transportation/
Monday, October 16th

Library Extension, Room 1 (LE1) (also called the Hui Pun Hing Lecture Hall) (see map page 6)

Workshop Organizers

CFD Workshop Chair
Dingxi Wang (Northwestern Polytechnical University)

Mehdi Vahdati, Xiao He
(Imperial College London)

Shenren Xu, Dongming Cao
(Northwestern Polytechnical University)

Senthil Krishnababu, Guangfeng An, Xianjun Yu
(SIEMENS Energy, Beihang University)

Domenico Mendicino, Benoit Tartinville
(Cadence Design Systems)

Fabian Klausmann
(Technical University Darmstadt)

CFD Plenary Keynote Speakers

Title: Revisiting the Verification and Validation of Turbomachinery CFD Codes
Shenren Xu
(Northwestern Polytechnical University, China)

Title: Validation of k-omega SST modifications in the turbomachinery context using two axial rotors
Natan Zawadzki
(University of Oxford, UK)

Provisional Program

Final program will be provided upon registration

10:30 - 10:50 Welcome and Introduction
Dingxi Wang (Northwestern Polytechnical University)

10:50 - 11:15 CFD Keynote Lecture
Natan Zawadzki (University of Oxford)

11:15 - 11:40 Summary of Participant Results for the BUAA Stage B Compressor
Jiazi Zhao (Northwestern Polytechnical University)

11:40 - 12:10 Participant Presentations x 3

12:10 - 14:25 Lunch

14:25 - 15:10 CFD Keynote Lecture
Shenren Xu (Northwestern Polytechnical University)

15:10 - 15:35 Introduction of the TUDa Compressor Dataset
Fabian Klausmann (TU Darmstadt)

15:35 - 16:00 Summary of Participant Results for the TUDa Compressor
Xiao He (Imperial College London), Dongming Cao (Northwestern Polytechnical University)

16:00 - 16:25 Coffee Break

16:25 - 16:50 Participant Presentations x 3

16:50 - 17:20 Summary of Participant Results for the ETH Turbine
Xuanlong Da (Northwestern Polytechnical University)

17:20 - 17:50 Participant Presentations x 3

17:50 - 18:00 Closing Remarks
Conference Schedule Overview

**Tuesday, October 17th**

08:15 | Author Briefing: Room 201, 217, 167, 103, 237, 141

09:00 - 09:10 | Loke Yew Hall
Opening Ceremony GPPS Hong Kong23

09:10 - 10:50 | Loke Yew Hall
Plenary Keynotes & Forum on Decarbonization

10:50 | (Convocation room 218 and Loke Yew Hall)
Coffee Break

11:10 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

12:25 - 13:25
Lunch Break @ Loke Yew Hall

13:25 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

14:45 | Loke Yew Hall
Plenary Keynote

15:30 | (Convocation room 218 and Loke Yew Hall)
Coffee Break

15:50 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

18:00 | Loke Yew Hall
Opening Reception

19:30 | By invitation only
Dinner “Women in Power and Propulsion Sectors”

**Wednesday, October 18th**

08:15 | Author Briefing: Room 201, 217, 167, 103, 237, 141

09:00 - 09:35 | Loke Yew Hall
Sponsor Presentations

09:35 - 11:05 | Loke Yew Hall
Plenary Keynotes & Forum on Advanced Computing

11:05 | (Convocation room 218 and Loke Yew Hall)
Coffee Break

11:25 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

12:40 - 13:40
Lunch Break @ Loke Yew Hall

13:25 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

14:20 | Loke Yew Hall
Technical Keynotes

15:35 | (Convocation room 218 and Loke Yew Hall)
Coffee Break

15:55 | Loke Yew Hall
Plenary Keynote

16:45 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

18:10 | Meeting Point in front of Main Building
Harbour Cruise

**Thursday, October 19th**

08:15 | Author Briefing: Room 201, 217, 167, 103, 237, 141

09:00 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

10:40 | (Convocation room 218 and Loke Yew Hall)
Coffee Break

11:00 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

12:15 - 13:15
Lunch Break @ Loke Yew Hall

13:15 | Room 201, 217, 167, 103, 237, 141
Paper Sessions

14:05 | Room 201, 217, 167
Technical Keynotes

14:40 | (Convocation Room 218 and Loke Yew Hall)
Coffee Break

15:00 | Loke Yew Hall
Plenary Keynotes & Forum on Future Energy

16:40 - 17:00 | Loke Yew Hall
Closing Ceremony & Hong Kong23 Student Paper Awards

18:00 - 19:15 | Harbour Cruise
Dinner "Women in Power and Propulsion Sectors"
GPPS Hong Kong Organizing Committee

Conference Chair:
Prof. Lixi Huang
The University of Hong Kong, China
Lixi Huang graduated from the Department of Jet Propulsion at Beijing Institute of Aeronautics (now Beihang Univ) in 1984 with a bachelor’s degree and in 1987 with a master’s degree specializing in compressor aerodynamics. He then studied in the acoustic lab of Cambridge University Engineering Department and completed his PhD work there in 1991. He taught at The Hong Kong Polytechnic University from 1996 and moved to the University of Hong Kong in 2006 where he now serves as a professor, teaching aeronautics and acoustics. His current research interest is in noise and flow instability control and he consults extensively for industry on noise issues.

Executive Conference Chair:
Prof. Zhanxue Wang
Northwestern Polytechnical University, China
Prof. Wang received his Ph.D. from the Department of Aero-Engine of Northwestern Polytechnical University (NPU) in 1998. He also earned a Master’s in engineering from the Department of Aero-Engine of NPU in 1995. Dr. Wang is a professor in the Fluid Mechanics Department of the College of Power and Energy. From October 1998 to November 2000, he worked as a postdoctoral researcher at Jiangsu Chunlan Group Postdoctoral Research Station. In 2019, he was selected for the National Project of Ten Million Talents and awarded the title of “Young and Middle-aged Experts with Outstanding Contributions”.

Review Chair:
Prof. Budimir Rosic
University of Oxford, UK
Budimir Rosic is an Associate Professor of Engineering Science and a Fellow at St Anne’s College, at the University of Oxford. He completed his Ph.D. at the Whittle Laboratory in Cambridge where he also worked as a Senior Research Fellow and College Lecturer. He moved to Oxford in 2009 and has continued his research there.

Review Co-Chair:
Prof. Dingxi Wang
Northwestern Polytechnical University, China
Dingxi is currently a professor and head of the department of fluid machinery at school of Power and Energy, Northwestern Polytechnical University. He obtained his Bachelor degree and Master degree in engineering at Northwestern Polytechnical University in 2002 and 2005 respectively and his PhD in computational fluid dynamics at University of Durham in 2009.

Technical Program Chair:
Dr. Chyiuki Nakamata
IHI Corporation, Japan
Chyiuki Nakamata received her master’s degree in physics from Ochanomizu University in 1993. Nakamata started her career at IHI as a turbine cooling designer and research engineer. Nakamata has worked as a research engineer in the areas of heat transfer and cooling technology, and she received her doctor degree in mechanical engineering from Iwate University in 2007. During her 27 years of experience at IHI, she participated in Japanese technology development programs and engine development programs.

Technical Program Co-Chair:
Prof. Min Zhu
Tsinghua University, China
Min Zhu received a B.S. degree from Tsinghua University in 1988, an M.S. degree from the National Institute of Metrology, China, in 1991, respectively, and a Ph.D. degree from the University of Cambridge, Britain, in 1996. He is currently a Full Professor at the Department of Energy and Power Engineering, at Tsinghua University. His research interests focus on flame dynamics, thermoacoustics, and low-carbon energy.

GPPS Professional Membership
Join today and benefit from our member offers
Designated for senior academia members and professionals with more than two years working experience.
Visit our website for a full listing of benefits and options.

GPPS Hong Kong Organizing Committee
GPPS Executive Committee

Chairman
Bernhard Winkelmann
USA

Vice Chairman & Treasurer
Prof. Mehdi Vahdati
Imperial College London, UK

Dr. Klaus Brun
Elliott Group, USA

Dr. Rainer Kurz
Solar Turbines, USA

Dr. Youngchang Shon
Hanwha General Chemical, South Korea

Prof. Susumu Teramoto
University of Tokyo, Japan

Prof. Shan-Tung Tu
East China University of Science and Technology, China

Dr. Jinzhang Feng
AECC, China

Prof. Reza Abhari
ETH Zurich, Switzerland

Dr. Jinzhang Feng
Xi'an Jiaotong University, China

Dr. Jochen Gier
MTU, Germany

Dr. Albert Kammerer
Ansaldo, Switzerland

Mr. Hiroshi Kuroki
IHI, Japan

Ir. Edmund KH Leung
Past President, HKIE, Hong Kong, China

Prof. Richard Parker
Imperial College, UK

Prof. Max Shen – Honorary Chair
The University of Hong Kong, China

Prof. Wei Shyy
Past President, Hong Kong University of Science and Technology, China

Prof. Xiaofeng Sun
Beihang University, China

Prof. Shan-Tung Tu
East China University of Science and Technology, China

Prof. Hong Yan
Northwestern Polytechnical University, China

Mr. Zhen Guo Yao
Siemens Energy China, China

Prof. Xin Yuan
Tsinghua University, China

Local Organizing Committee

Prof. Song Cheng
Hong Kong Polytechnic University, China

Prof. Juan Du
CAS Inst of Engineering Thermophysics, Beijing, China

Prof. Yingzheng Liu
Shanghai Jiaotong University, China

Prof. Yun Wu
Xi'an Jiaotong University, China

Prof. Simon Yu
Hong Kong Polytechnic University, China
IHI Corporation is thriving as a leading jet engine and rocket manufacturer in Japan, contributing to commercial engine development programs worldwide. With its indomitable spirit of challenge and cutting-edge technology, IHI is committed to contributing to the realization of the dreams of the human race and the sustainable development of society through safe and clean air transport, reliable defense systems, and space utilization.

www.ihi.co.jp/en

The School of Mechanical and Power Engineering of East China University of Science and Technology adheres to the concept of integrating scientific research with national needs to “lead technological innovation at the source of high-end equipment, strengthen cutting-edge research on basic theories of safety, greenness, reliability, and intelligence, and cultivate high-level talents with innovative capabilities.”

https://mech.ecust.edu.cn

LiuGu Power focuses on the research and development of simulation software tools, engineering design consulting, experimental testing and verification in the field of professional design. Currently, it has more than ten industrial simulation software products and more than 60 software copyrights and invention patents.

www.lgsim.com

Cathay Vista is committed to developing safe, clean, and efficient energy transferring technologies, to better promote the implementation of low carbon emission society.

www.cathayvista.com

MAPNA Group is a leading Iranian industrial enterprise whose business covers diverse infrastructure lines: power generation, oil & gas, rail transportation, and investment. The company manufactures a diverse range of industrial machinery, from turbines and generators to turbo compressors and locomotives. MAPNA also serves as a solution provider for projects both inside and outside Iran.

www.mapnagroup.com

Northwestern Polytechnical University is a national key public research university in Xi’an, China. The university is funded by the Ministry of Industry and Information Technology. The university is a Chinese national Class A Double First Class University. The research capacities of NPU are evident in its array of research facilities and programmes, including eight national-level key laboratories, two national engineering research centres, three high-level bases for international collaboration on science and technology, and four national-local joint innovation platforms.

www.nwpu.edu.cn

Hanwha Power Systems is one of the fastest growing companies in Power and Energy solution market. And also the goal of accelerating the transition to clean energy across our society and industry, acquired hydrogen combustion technology companies.

www.hanwha.com

IHI Corporation is thriving as a leading jet engine and rocket manufacturer in Japan, contributing to commercial engine development programs worldwide. With its indomitable spirit of challenge and cutting-edge technology, IHI is committed to contributing to the realization of the dreams of the human race and the sustainable development of society through safe and clean air transport, reliable defense systems, and space utilization.

www.ihi.co.jp/en

LiuGu Power focuses on the research and development of simulation software tools, engineering design consulting, experimental testing and verification in the field of professional design. Currently, it has more than ten industrial simulation software products and more than 60 software copyrights and invention patents.

www.lgsim.com

The School of Mechanical and Power Engineering of East China University of Science and Technology adheres to the concept of integrating scientific research with national needs to “lead technological innovation at the source of high-end equipment, strengthen cutting-edge research on basic theories of safety, greenness, reliability, and intelligence, and cultivate high-level talents with innovative capabilities.”

https://mech.ecust.edu.cn
Wuhan Engineering University was founded in 1972 under the former Ministry of Chemical Industry. The school is a multi-disciplinary teaching and research university focusing on engineering, and is a “first-class discipline” university in Hubei Province. [https://en.whu.edu.cn](https://en.whu.edu.cn)

Journal of Propulsion Technology covers all disciplines in the field of propulsion, including aviation, aerospace and navigation. It is devoted to publishing both original papers and review papers written either in Chinese or English. [www.tjjscasic.cn](http://www.tjjscasic.cn)

CLP Power Hong Kong Limited (CLP Power) is the Hong Kong utility subsidiary wholly owned by CLP Holdings Limited, a company listed on the Hong Kong Stock Exchange and one of the largest investor-owned power businesses in Asia. CLP Power operates a vertically integrated electricity supply business in Hong Kong, and provides a highly reliable supply of electricity and excellent customer services to more than six million people in its supply area. [www.clp.com.hk](http://www.clp.com.hk)

《推进技术》由中国航天科工集团有限公司主管, 中国航天科工集团三十一研究所主办。创刊于1980年, 月刊, 国内外公开发行。自创刊以来持续被EI、Scopus、北大核心等数据库收录，是中文“双核心”期刊，2019年入选中国科协卓越行动计划及《航空航天领域高质量科技期刊分级目录》T2级，连续两届获评“全国百强报刊”，多篇论文入选中国科协优秀科技论文遴选计划。期刊的办刊宗旨是坚持质量精品化、内容专业化、编辑规范化、管理科学化，刊登各类飞机、无人机、导弹、运载器、航天器和舰船推进系统在理论研究、设计、试验等方面的学术论文，推动涡轮、冲压、火箭、爆震、激光、核能、电推进、组合推进、新概念及新型推进技术的发展与进步。

GPPS is grateful for the continuous support received from AECC
Keynote Speakers (alphabetical order)

Plenary Keynotes

**Title:** Challenges and Opportunities for Decarbonizing Power Generation  
**Dr. Xuelin Gao:** Mitsubishi Heavy Industries, Japan  
Xuelin Gao received his Bachelor and Phd degrees from Tsinghua University in 2002 and 2007, and since joined MHI Takasago Research & Development Center. From 2010 to 2018, he led the project of CFD design tool’s development for the compressor and turbine of the heavy duty gas turbines, and joined the design of MHI’s J-type gas turbine compressor. From 2019, he has been assigned to MHI Global Research & Innovation Center as a research manager cooperating with world-wide universities, and holds the position of General Manager of MHI Global Research & Development China Office.

**Title:** Sustainable Aviation Fuel: Prospects and Challenges  
**Mr. Yasushi Hashimoto:** Japanese Aero Engines Corporation (JAEC), Japan  
Yasu Hashimoto is a Project Management Manager for Japanese Aero Engines Corporation (JAEC), an organization aimed to lead the country’s aviation turbine engine business, jointly run by Japanese heavy industry companies and government. Yasu has been assigned to the current position from the organization’s co-founder IHI Corporation, and manages various R&D projects of commercial jet engine components.

**Title:** Status and Challenges of AI-driven Big Model for Smart Maintenance of Turbomachines  
**Prof. Xiaomo Jiang:** Dalian University of Technology, China  
Distinguished Professor of Energy and Power Engineering at Dalian University of Technology and State Key Lab of Structural Analysis, Optimization and CAE Software for Industrial Equipment, and Director of Research Institute for Carbon Neutrality and Provincial Key Lab of Digital Twin for Industrial Equipment at Liaoning.

**Title:** Robotics Challenges for Fusion Energy  
**Dr. Henry Lau:** UK Atomic Energy Authority, UK  
Henry is the Head of Cybernetics at Remote Applications in Challenging Environment (RACE) Division at the UK Atomic Energy Authority (UKAEA). He was the Associate Dean (Innovation) in Engineering at HKU and the Director of the Human-Systems Interaction and Simulation Laboratory. Henry’s research focus on robotics and artificial intelligence, in particular, artificial immune systems (AIS) which is a computation and engineering analogy of the biological immune systems.

**Title:** Nuclear Power as a Sustainable Energy Option  
**Prof. Chin Pan:** City University of Hong Kong, China  
Prof. PAN Chin is now CLP Power chair professor of nuclear engineering and head of the Department of Mechanical Engineering, City University of Hong Kong. He received his BS degree in nuclear engineering from National Tsing Hua University (NTHU) in 1979, MS and PhD degrees in nuclear engineering from University of Illinois at Urbana-Champaign (UIUC) in 1983 and 1986, respectively. Prof. Pan’s research activities for the past two decades have been in the general areas of multi-phase flow and boiling heat transfer.

**Title:** Revolutionizing Energy Applications with Advanced Compute  
**Dr. Christopher Savoie:** Zapata AI, USA  
Christopher Savoie is a published scholar in medicine, biochemistry, and computer science, and his research and business interests over the years have focused on the intersection of machine learning, biology, and chemistry. Savoie is the original inventor of AAOSA, the A.I.-based natural language interface technology used to develop Apple’s Siri.

**Title:** Compact High-order Algorithms for Simulation in Turbomachinery with Sliding Mesh  
**Prof. Kun Xu:** Hong Kong University Science & Technology, China  
In 1987, Prof. Kun Xu received his B.S. degree from Beijing University, and in 1993, he earned his Ph.D. degree from Columbia University. Following his Ph.D., he worked as a post-doctoral researcher at Princeton University before joining the Hong Kong University of Science and Technology (HKUST) in 1996. Currently, he holds the position of Stephen Kam Chuen Cheong Professor of Science and Chair Professor at the Mathematics Department and Mechanical and Aerospace Engineering Department at HKUST.

**Title:** The Development and Application of Space Solar Power  
**Dr. Ming Li:** Chinese Society of Astronautics, China  
Dr. Ming Li, a professor, and Ph.D. adviser, is a member of the Chinese Society of Astronautics. He won the second class prize of the National Science and Technology Progress Award twice. Dr. Li is appointed as the chairman of the Committee of Space Solar Power Station, Chinese Society of Astronautics. He serves as a member of the Space Power Technical Committee of the International Astronautical Federation (IAF). He is currently a member of the IAF Honor and Awards Committee and a member of the International Academy of Astronautics.

**Title:** Turbomachinery for Hard-to-abate High Emission Industries  
**Dr. Liping Xu:** University of Cambridge, UK  
Liping Xu recently retired from University of Cambridge as a university associate professor in turbomachinery. He has a Bachelor degree from BUAA and a PhD from Cambridge in early and middle of 1980’s and since has worked in the field of turbomachinery. His interests cover wide range of turbomachinery aero-thermal dynamic problems in aeromachines, gas turbines, steam turbines and turbochargers. In last fifteen years, he has been working with Coolbrook Oy to assist the company to develop their ground-breaking products RDR and RDH, the new turbo-machines which are in the centre of this talk.
Technical Keynotes

**Title:** Stall Margin Improvement on Axial Compressors: Integrated Design of Axial Slot Casing Treatment and Blades  
**Prof. Juan Du:** Chinese Academy of Sciences, China  
Dr. Du is a member of Youth Innovation Promotion Association of Chinese Academy of Sciences (CAS). In 2009, she studied for one year as a visiting scholar in Department of Aerospace and Mechanical Engineering, University of Notre Dame, USA. In 2010, she got her Ph.D. degree from Institute of Engineering Thermophysics Chinese Academy of Sciences. From 2014 to 2016, funded by Humboldt Research Fellowship, she served as a Postdoctoral Researchers at Institute of Turbomachinery and Fluid-dynamics, Leibniz University Hannover, Germany. Professor Joerg R. Seume was her host Professor.

**Title:** The Next Age of Turbomachinery Noise Predictions  
**Prof. Wei Fan:** Northwestern Polytechnical University, China  
Dr. Fan is a professor and Ph.D. supervisor at Northwestern Polytechnical University. Her research and teaching focus on "detonation propulsion and supercritical combustion". She has published more than 340 papers in top journals such as Combustion and Flame, Proceedings of the Combustion Institute, with 72 indexed by SCI and 211 indexed by EI. She has also been granted 57 patents and has published 4 books. Currently, Prof. Fan serves as Vice Chairman of the Combustion Branch of the Chinese Society of Engineering Thermophysics, Chairman of the Combustion and Heat Transfer Experts Committee of the Power Branch of the Chinese Society of Aeronautics and Astronautics, and associate chief editor of the Journal of Aerospace Power.

**Title:** Development Trend of Low Carbon and Electrification Technologies in Aviation Power  
**Prof. Shijin Shuai:** Tsinghua University, China  
Prof. Shuai is a professor at Tsinghua University, a vice president of AeroEngine Research Institute at Tsinghua University, and the director of Tsinghua University-SHELL Joint Research Center for Clean Mobility. He is a fellow of the China Society of Automotive Engineering (SAE-China), an executive director of Chinese Society of Internal Combustion Engine (CSICE), a director of Fuel and Lubricants Committee of CSICEs, a vice director of Aviation Engine Committee of CSICEs. His research interests include engine spray combustion and emission control, hybrid engine, fuel cell engine for transportation.

**Title:** The Research and Development of Detonation-based Engines  
**Prof. Wei Fan:** Northwestern Polytechnical University, China  
His research and teaching focus on "detonation propulsion and supercritical combustion". She has published more than 340 papers in top journals such as Combustion and Flame, Proceedings of the Combustion Institute, with 72 indexed by SCI and 211 indexed by EI. She has also been granted 57 patents and has published 4 books. Currently, Prof. Fan serves as Vice Chairman of the Combustion Branch of the Chinese Society of Engineering Thermophysics, Chairman of the Combustion and Heat Transfer Experts Committee of the Power Branch of the Chinese Society of Aeronautics and Astronautics, and associate chief editor of the Journal of Aerospace Power.

**Title:** Structural Integrity for Greener Power  
**Prof. Shan-Tung Tu:** East China University of Science and Technology, China  
Shan-Tung Tu received his B.Eng degree in 1982 and Ph.D degree in 1988 from Nanjing Tech University, is a Chair professor of Mechanical Engineering, East China University of Science and Technology. Prior to this, he has worked in Nanjing Tech University and East China University of Science and Technology as a professor and vice present, and a guest scientist to Royal Institute of Technology, Sweden. He was elected as a member of China Academy of Engineering in 2019.

**Title:** Prediction of Aerodynamic and Aeroelastic Instabilities of Fans  
**Prof. Mehdi Vahdati:** Department of Mechanical Engineering Imperial College London, UK  
Professor Vahdati is the Principal Research Fellow in the Dynamics Group and leads the Aeroelasticity Group in the Vibration Technology Centre sponsored by Rolls-Royce plc. His main research focus is the development of CFD algorithms, modeling fan blade flutter, turbine and compressor forced response, stall and surge modeling and aeroacoustic and aeroelastic phenomena. In practice, one of the main reasons for turbomachinery failure is vibration, and our work is directly relevant to the industry. Through modeling, the behavior and mitigating causes of engine failures lead to substantial increases in safety and reliability, provides energy-efficient environmental friendly benefits and significant cost savings.
## Conference Paper Sessions

<table>
<thead>
<tr>
<th>Paper Sessions</th>
<th>Day</th>
<th>Page</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>Tue, Wed, Thur</td>
<td>22, 23, 24, 25, 29, 30, 32, 33, 39, 40</td>
<td>Combustor &amp; Combustion</td>
</tr>
<tr>
<td>DEFIGT</td>
<td>Thur</td>
<td>37, 38</td>
<td>Deposition, Erosion, Fouling &amp; Icing in Gas Turbines</td>
</tr>
<tr>
<td>DNECII</td>
<td></td>
<td></td>
<td>Ducts, Nozzles, Exhausters &amp; Component Interaction and Integration</td>
</tr>
<tr>
<td>ESC</td>
<td>Tue</td>
<td>25</td>
<td>Energy Systems &amp; Carriers</td>
</tr>
<tr>
<td>ETR</td>
<td>Tue</td>
<td>24, 25</td>
<td>Energy Transition &amp; Renewables</td>
</tr>
<tr>
<td>HTGI</td>
<td>Tue</td>
<td>34</td>
<td>Heat Transfer: General interest</td>
</tr>
<tr>
<td>HTFC</td>
<td>Wed, Thur</td>
<td>29, 39</td>
<td>Heat Transfer: Film cooling</td>
</tr>
<tr>
<td>HTIC</td>
<td>Tue, Wed</td>
<td>22, 23, 29, 30</td>
<td>Heat Transfer: Internal cooling</td>
</tr>
<tr>
<td>HTDAM</td>
<td>Thur</td>
<td>37, 38</td>
<td>Heat Transfer: Design and analysis methods</td>
</tr>
<tr>
<td>ICTMD</td>
<td>Tue, Wed</td>
<td>24, 25, 34, 35</td>
<td>Instrumentation, Control, Testing, Monitoring &amp; Diagnostics</td>
</tr>
<tr>
<td>SASS</td>
<td></td>
<td></td>
<td>Secondary Air System &amp; Sealing</td>
</tr>
<tr>
<td>SMSV</td>
<td>Thur</td>
<td>38, 39, 40</td>
<td>Mechanics and Materials: Stress and vibration</td>
</tr>
<tr>
<td>SMFFL</td>
<td></td>
<td></td>
<td>Mechanics and Materials: Fatigue, fracture and life</td>
</tr>
<tr>
<td>SMR</td>
<td></td>
<td></td>
<td>Mechanics and Materials: Rotordynamics</td>
</tr>
<tr>
<td>SMSBD</td>
<td></td>
<td></td>
<td>Mechanics and Materials: Seal/bearing dynamics</td>
</tr>
<tr>
<td>SMDAM</td>
<td>Tue, Thur</td>
<td>22, 37, 38</td>
<td>Mechanics and Materials: Design and analysis methods</td>
</tr>
<tr>
<td>SC</td>
<td>Tue</td>
<td>21, 22</td>
<td>Supercritical CO2</td>
</tr>
<tr>
<td>TCPP</td>
<td>Tue, Wed</td>
<td>22, 23, 29, 32, 33</td>
<td>Thermodynamic Cycles for Power and Propulsion</td>
</tr>
<tr>
<td>TAAFC</td>
<td>Tue, Wed, Thur</td>
<td>21, 22, 23, 24, 25, 29, 30, 32, 33, 39, 40</td>
<td>Turbomachinery Aerodynamics: Axial-flow compressors</td>
</tr>
<tr>
<td>TARMFC</td>
<td>Thur</td>
<td>37, 38</td>
<td>Turbomachinery Aerodynamics: Radial/mixed-flow compressors</td>
</tr>
<tr>
<td>TAFB</td>
<td>Thur</td>
<td>39, 40</td>
<td>Turbomachinery Aerodynamics: Fans/blowers</td>
</tr>
<tr>
<td>TAT</td>
<td>Wed</td>
<td></td>
<td>Turbomachinery Aerodynamics: Turbochargers, small turbomachines, new applications</td>
</tr>
<tr>
<td>TAARFT</td>
<td>Wed</td>
<td>29, 30, 34, 35</td>
<td>Turbomachinery Aerodynamics: Axial/radial-flow turbines</td>
</tr>
<tr>
<td>TAST</td>
<td>Tue</td>
<td>21, 22</td>
<td>Turbomachinery Aerodynamics: Steam turbines</td>
</tr>
<tr>
<td>TAWT</td>
<td>Thur</td>
<td>40</td>
<td>Turbomachinery Aerodynamics: Wind turbines</td>
</tr>
<tr>
<td>TADAM</td>
<td>Tue, Wed, Thur</td>
<td>23, 32, 33, 39, 40</td>
<td>Turbomachinery Aerodynamics: Design and analysis methods</td>
</tr>
<tr>
<td>TAF</td>
<td>Wed</td>
<td>34, 35</td>
<td>Turbomachinery Aeroelasticity: Flutter</td>
</tr>
<tr>
<td>TAFR</td>
<td>Wed</td>
<td>32, 33</td>
<td>Turbomachinery Aeroelasticity: Forced response</td>
</tr>
<tr>
<td>TANV</td>
<td>Wed</td>
<td>34, 35</td>
<td>Turbomachinery Aeroelasticity: Nonsynchronous vibration</td>
</tr>
<tr>
<td>TAEDAM</td>
<td>Thur</td>
<td>38</td>
<td>Turbomachinery Aeroelasticity: Design and analysis methods</td>
</tr>
<tr>
<td>TUAGI</td>
<td>Tue</td>
<td>21</td>
<td>Turbomachinery Unsteady Aerodynamics: General interest</td>
</tr>
<tr>
<td>TUARSRI</td>
<td>Tue, Wed, Thur</td>
<td>21, 22, 29, 30, 37, 38</td>
<td>Turbomachinery Unsteady Aerodynamics: Rotating stall, rotating instability and surge</td>
</tr>
<tr>
<td>TUABRIID</td>
<td>Thur</td>
<td>37</td>
<td>Turbomachinery Unsteady Aerodynamics: Blade row interaction and inlet distortion</td>
</tr>
<tr>
<td>TUADAM</td>
<td>Tue</td>
<td>24, 25</td>
<td>Turbomachinery Unsteady Aerodynamics: Design and analysis methods</td>
</tr>
<tr>
<td>P</td>
<td>Tue</td>
<td>21, 22</td>
<td>Pumps</td>
</tr>
</tbody>
</table>
Track Chairs

The organizers would like to express their appreciation to the Hong Kong23 Track Chairs for their help, support and dedication throughout the review process and beyond.
Presenting Authors

Paper Number, Session Code, Page number | Surname, First Name

004, SMSV, P39 | Rong, Jiasheng
008, TADAM, P22 | Zhang, Yixiao
010, TADAM, P32 | Grubert, Jonas
011, TAARFT, P23 | Zhang, Gangduo
019, TADAM, P39 | Wang, Haohao
014, ICTMD, P34 | Wang, Shang
015, TUADAM, P25 | Zheng, Xuedong
016, HTIC, P29 | Ito, Ryuta
017, TADAM, P40 | Fan, Jiazheng
018, TAARFT, P37 | Li, Jian
020, TAARFT, P34 | Huo, Dongchen
021, DEFIGT, P38 | Zhang, Tianlun
022, TAARFT, P28 | Li, Yi
023, CC, P39 | Huang, Weicheng
027, TAACF, P24 | Deng, Hefang
029, TAARFT, P37 | Kong, Weihuan
031, ICTMD, P34 | Yao, Chunhui
033, ICTMD, P34 | Hu, Fang
035, TAARFT, P29 | Ni, Haoyu
037, TAARFT, P33 | Huang, Zijian
038, CC, P32 | Yuan, Minpeng
040, TAFB, P39 | Le Roux, Tristan Oliver
041, TUADAM, P25 | Xu, Jiasen
042, SMSMS, P39 | Liang, Daosong
044, TAARFT, P29 | Hu, Kexin
047, TAACF, P32 | Zhang, Ruichen
048, TAACF, P27 | Feng, Hanlin
049, TCPB, P29 | Xia, Yizhen
050, TADAM, P39 | Xing, Xiaolong
051, HTIC, P39 | Huang, Tong
052, DNECII, P34 | Feng, Ruishi
053, TAACF, P23 | Liu, Tiantao
054, TAARFT, P38 | Guo, Yanchao
056, TAACF, P30 | Sagan, Lukas
056, TAACF, P30 | Schulz, Yannik
057, TAARFT, P38 | Yang, Fan
059, TAARFT, P29 | Chen, Zeshuai
061, ETR, P24 | Lin, Yashan
063, TAACF, P40 | Zhang, Botao
066, TARMF, P37 | Shen, Xin
068, HTIC, P22 | Lu, Yujun
071, TAACF, P29 | Sun, Ke
072, SMSV, P40 | Sun, Minghui
074, TAURSIS, P21 | Li, Hefei
075, TAEDAM, P38 | Li, Xiaojing
077, CC, P29 | Zhang, Xiaoxiu
078, TADAM, P39 | Huo, Dongchen
080, DNECII, P34 | Kirsch, Bastian
082, TAACF, P23 | Fan, Zhonggang
083, TAACF, P21 | Wei, Haifeng
084, TAST, P21 | Kang, Ming
085, HTDM, P37 | Jiang, Huadong
086, TAARFT, P34 | Long, Qiyun
087, TUAG, P21 | Hu, Yifan
088, CC, P39 | Wang, Kechen
090, TAF, P34 | Guo, Penghui
091, TAACF, P21 | Wang, Yunyu
093, AN, P23 | Zhang, Hanzhuo
094, DEFIGT, P37 | Hao, Zihan
095, TAWT, P40 | Qu, Chunming
097, TAURSIS, P30 | Qi, Jiahui
098, TAARFT, P35 | Wang, Yufen
099, ICTMD, P24 | Meng, Yiming
100, TAUBRIID, P37 | Tian, Cheng
101, TAARFT, P30 | Jiang, Chi Ju
103, TAACF, P21 | Gao, Xi
104, HTDM, P38 | Shi, Lei
105, TAACF, P22 | Zhao, Hongliang
106, TAST, P21 | Ma, Bangyan
109, TAACF, P32 | Li, Min
110, TAACF, P32 | Lang, Jinhua
112, TADAM, P23 | Zhang, Xuyuan
113, HTIC, P23 | Wang, Yi
114, CC, P40 | Liu, Tengyu
115, DEFIGT, P38 | Ray, Saroj
117, TAUBRIID, P37 | Sun, Enbo
118, CC, P36 | Yang, Ningjing
120, TADAM, P24 | Wang, Boqian
121, P, P29 | Wang, Zhouqin
122, TADAM, P40 | Han, Zichen
123, TADAM, P29 | Zang, Sen
126, HTIC, P39 | Yi, Baichuan
127, DNECII, P34 | Wei, Xiaoping
130, TARMF, P37 | Li, Ziliang
132, TCPB, P23 | Zou, Wangzhi
133, TAACF, P33 | Ruixing, Liang
135, TAF, P38 | Cao, Dongming
138, SMSV, P40 | Nakos, Alex
140, TAF, P32 | Wu, Hangkong
144, TAACF, P39 | Li, Shanzhen
146, TUADAM, P25 | George, Amelia
153, TARMF, P38 | Liu, Jun-nan
154, CC, P25 | Cui, Yanqiong
158, TCPB, P22 | Yu, Shida
159, ESC, P25 | Wang, Chusha
163, TAURSIS, P29 | Yoon, Youngkum
164, TUADAM, P24 | Ishimoto, Yuma
167, HTDM, P37 | Cai, Feixue
172, CC, P33 | Cao, Zhenpeng
173, TAACF, P21 | Giannini, Samuele
175, TAFB, P39 | Xu, Tianyu
178, CC, P32 | Wang, Can
179, ETR, P23 | Khan, Aamir
180, HTIC, P29 | Zeng, Wei
182, ICTMD, P24 | Wang, Zepeng
184, ICTMD, P25 | Wang, Ye
187, TANV, P35 | Zhang, Yucheng
189, AN, P24 | Karabasov, Sergey
191, TAACF, P23 | Qian, Kun
192, TAACF, P23 | Yang, Zonghao
193, SC, P22 | Ma, Can
194, HTDM, P38 | Baker, Mark
196, TAF, P34 | Zhao, Fanzhou
197, TCPB, P22 | Deng, Weimin
198, TANV, P34 | Yang, Jingjie
201, SC, P21 | Zhou, Mingshuo
202, CC, P23 | Xue, Silu
204, AN, P25 | Zhang, Liangji
208, CC, P23 | Zhu, Xu
210, TAFF, P33 | Klausmann, Fabian
216, CC, P24 | Lu, Ziting
220, AN, P25 | Zhao, Xinyu
223, TCPB, P32 | G€oning, Jan
226, TAFB, P40 | Delibra, Giovanni
227, HHTC, P33 | Zhou, Xu
230, ESC, P25 | Li, Weifeng
230, ESC, P25 | Qiang, Xuanke
231, TAACF, P25 | Wei, Xindi
235, TAACF, P25 | Wei, Xindi
236, TCPB, P22 | Kurze, Joachim
238, TAST, P22 | Schleier, Matthias
239, P, P21 | Xie, Nan
240, ICTMD, P25 | Jung, Daniel
243, P, P22 | Xie, Nan
244, TAEDAM, P38 | Yu, Zhifan
245, TAACF, P32 | Rubini, Dylan
247, TAF, P35 | Corral, Roque
250, SC, P22 | Xu, Pengcheng
251, TCPB, P33 | Liu, Dechen
252, TAACF, P31 | Liu, Qiang
254, HTG, P34 | Tang, Zhongfu
260, CC, P33 | Yang, Tao
261, CC, P23 | Zhou, Yuyang
263, HTIC, P30 | Cheng, Xiang
266, TAURSIS, P22 | Fujisawa, Nobumichi
268, AN, P23 | Rahmati, Mohammad
269, CC, P25 | Ge, Bing
272, TANV, P34 | Tateishi, Atsushi
273, TADAM, P32 | Petkovic, Djordje
276, SMDAM, P38 | Kang, Seung-Hoon
277, CC, P33 | Hiestermann, Marian
281, TADAM, P33 | Sun, Enbo
283, TAACF, P32 | Zawadzki, Natan
284, TAACF, P29 | Liu, Yangwei
286, TUARIS, P39 | Zawadzki, Natan
287, TAF, P40 | Xu, Yibing
291, TAACF, P38 | Xu, Xiaoyan
295, TAACF, P39 | Lili, Fan
298, SMSV, P38 | Jing, Xin
301, TAACF, P25 | Wang, Hejian
303, TCPB, P29 | Yuk-Hung, Mau
304 Invited, P37 | Gao, Wenjun
305 Invited, P39 | Mao, Xiaochen
306 Invited, P39 | Wang, Zhiviu
307 Invited, P24 | Guo, Hengjie
310 Invited, P39 | Zheng, Xiao-Tao
311 Invited, P24 | Ding, Peishan
312 Invited, P34 | Cao, Renjing
318 Invited, P33 | Sun, Xinrong
Detailed Schedule

During the three-day technical conference, plenary keynotes and panel discussions will take place in the Loke Yew Hall. Invited Talks and regular paper presentations will take place in the allocated parallel rooms (1 - 6) on floor 1 and 2, while Technical Keynotes will be held in the largest parallel rooms (201, 217, 167).

### Session Codes

- **CC**: Combustor & Combustion
- **DEFICT**: Deposition, Erosion, Fouling & Icing in Gas Turbines
- **DNECII**: Ducts, Nozzles, Exhausts & Component Interaction and Integration
- **ESC**: Energy Systems & Carriers
- **ETR**: Energy Transition & Renewables
- **HTGI**: Heat Transfer: General interest
- **HTFC**: Heat Transfer: Film cooling
- **HTIC**: Heat Transfer: Internal cooling
- **HTDAM**: Heat Transfer: Design and analysis methods
- **ICTMD**: Instrumentation, Control, Testing, Monitoring & Diagnostics
- **SASS**: Secondary Air System & Sealing
- **SMSV**: Mechanics and Materials: Stress and vibration
- **SMFFL**: Mechanics and Materials: Fatigue, fracture and life
- **SMR**: Mechanics and Materials: Rotordynamics
- **SMSBD**: Mechanics and Materials: Seal/bearing dynamics
- **SMDAM**: Mechanics and Materials: Design and analysis methods
- **SC**: Supercritical CO2
- **TCPP**: Thermodynamic Cycles for Power and Propulsion
- **TAAFC**: Turbomachinery Aerodynamics: Axial-flow compressors
- **TARMFC**: Turbomachinery Aerodynamics: Radial/mixed-flow compressors
- **TAFB**: Turbomachinery Aerodynamics: Fans/blowers
- **TAT**: Turbomachinery Aerodynamics: Turbochargers, new applications
- **TAARFT**: Turbomachinery Aerodynamics: Axial/radial-flow turbines
- **TAST**: Turbomachinery Aerodynamics: Steam turbines
- **TAWT**: Turbomachinery Aerodynamics: Wind turbines
- **TADAM**: Turbomachinery Aerodynamics: Design and analysis methods
- **TUAGI**: Turbomachinery Aeroelasticity: Nonsynchronous vibration
- **TUEDAM**: Turbomachinery Aeroelasticity: Design and analysis methods
- **TUARI**: Turbomachinery Unsteady Aerodynamics: General interest
- **TUABRIID**: Turbomachinery Unsteady Aerodynamics: Blade row interaction and inlet distortion
- **TUADAM**: Turbomachinery Unsteady Aerodynamics: Design and analysis methods
- **P**: Pumps

### Tuesday, October 17th

**08:15**
**Author briefing @ Located in each presentation room**

Room: Loke Yew Hall

**09:00**
**Opening Ceremony GPPS Hong Kong23**

Welcome speech: **Prof. Lixi Huang** (The University of Hong Kong, China)

Room: Loke Yew Hall

**09:10**
**Plenary Keynotes & Forum on Decarbonization**

Speaker: **Dr. Liping Xu** (University of Cambridge, UK)
Title: **Turbomachinery for hard-to-abate high emission industries**

Speaker: **Dr. Xuelin Gao** (Mitsubishi Heavy Industries, China)
Title: **Challenges and Opportunities for Decarbonizing Power Generation**

Session Chair: **Prof. Seung Jin Song** (Seoul National University, Korea)
Tuesday, October 17th

Coffee Break @ Convocation Room 218 and Loke Yew Hall

Room 1
MB201
Session Chairs
Yangwei Liu + Xiaochen Mao

[TAAFC-103] Interaction Mechanism between Incoming Vortex and Tip Leakage Vortex Breakdown of a Compressor Cascade
→ Xi Cao
→ Zhiyuan Cao
→ Jing Yang
→ Chuxuan Wang
Northwestern Polytechnical University, China

[TAAFC-083] The Influence of Inlet Air Moisture Content on the Performance of Counter-Rotating Compressor
→ Haifeng Wei
→ Bo Liu
→ Ran Zhang
Northwestern Polytechnical University, China

[TAAFC-084] Analysis of High Temperature Flange & Bolt Temperature Variation of the Steam Turbine Cylinder During Start-up Process Based on in-service Data
→ Ming Kang ¹
→ Shi-Fang Wu ²
→ Geng-Hui Jiang ¹
→ Wei-Zhe Wang ¹
¹ Shanghai Jiao Tong University, China
² Shanghai Electric Power Generation Equipment Co., Ltd, China

Room 2
MB217
Session Chairs
Qiang Liu + Baotong Wang

[TAAFC-091] Numerical Investigation of the Potential of Multi-Row Optimization of an Axial Compressor Stage with a Tandem Vane Stator
→ Samuele Giannini
→ Mattia Straccia
→ Philipp von Jeinsen
→ Sagnik Banik
→ Volker Gümmer
Technical University of Munich, Germany

[TAAFC-173] Influence of End-slot Based on the Incoming Flow Momentum on the Corner Separation of a Transonic Compressor Stator
→ Yunyu Wang
→ Xiaochen Mao
→ Bo Liu
→ Hejian Wang
Northwestern Polytechnical University, China

[TAST-016] Evaluation of the Cooling Flow Rate of the Cooled Steam Turbine for a Novel H₂/O₂ Cycle
→ Bangyan Ma ¹
→ Lei Shi ¹
→ Yan Li ¹
→ Xiaocheng Zhu ³
→ Zaohuai Du ¹
¹ Shanghai Jiao Tong University, China
² China United Gas Turbine Technology Co., Ltd, China
³ Harbin Engineering University, China

Room 3
MB167
Session Chairs
Matthias Schleer + Budimir Rosic

[TAAFC-081] Influence of the Potential of Multi-Row Optimization of an Axial Compressor Stage with a Tandem Vane Stator
→ Samuele Giannini
→ Mattia Straccia
→ Philipp von Jeinsen
→ Sagnik Banik
→ Volker Gümmer
Technical University of Munich, Germany

[TAST-084] Analysis of High Temperature Flange & Bolt Temperature Variation of the Steam Turbine Cylinder During Start-up Process Based on in-service Data
→ Ming Kang ¹
→ Shi-Fang Wu ²
→ Geng-Hui Jiang ¹
→ Wei-Zhe Wang ¹
¹ Shanghai Jiao Tong University, China
² Shanghai Electric Power Generation Equipment Co., Ltd, China

Room 4
MB103
Session Chairs
Wenqiang Zhang + Weihan Kong

→ Min Yao ¹
→ Chen Chen ²
¹ Tsinghua University, China
² University of Oxford, UK

Room 5
MB237
Session Chair
Michael Pekris

[P-121] Optimized Design Of Tidal Current Turbine Blade At Low Current Rate
→ Zhouqin Wang
→ Siqi Lai
→ Zhiyuan Gao
→ Hongwei Liu
Zhejiang University, China

Room 6
MB141
Session Chairs
Xiaodong Ren + Joachim Kurzke

[SC-193] Multi-fidelity Aerodynamic Performance Modelling of Supercritical Carbon Dioxide Compressor
→ Can Ma
→ Jinlan Guo
→ Xingsheng Lao
→ Kelong Zhang
→ Wei Wang
Wuhan Second Ship Design and Research Institute, China

[TUARSRIS-074] Analysis of Axial Compressor Rotating Instability Characteristics with Different Axial Clearances by POD Method
→ Hefei Li
→ Qun Zheng
→ Bin Jiang
Harbin Engineering University, China

[P-239] Investigation of Unsteady Cavitation Flow around a Hydrofoil using GAS Method
→ Nan Xie
→ Yumeng Tang
→ Jixuan Hou
→ Yangwei Liu
Beihang University, China

[SC-201] Predictive Performance of Thermophysical Properties of Supercritical Carbon Dioxide using Gaussian Process and Deep Learning
→ Xingjian Wang
→ Mingzhuo Zhou
→ Chenxi Ni
Tsinghua University, China
Tuesday, October 17th

12:00

→ Xindi Wei
→ Yumeng Tang
→ Yangwei Liu
Beihang University, China

[TAACF-105] Numerical simulation of inlet total pressure distortion on a two-stage high-speed axial fan
→ Hongliang Zhao
→ Weniqiang Zhang
→ Jiahui Qiu
→ Min Zhang
→ Juan Du
→ Chaoqun Nie
1 North China Electric Power University, China
2 Beijing Institute of Technology, China
3 Chinese Academy of Sciences, China

12:25

Lunch Break @ Loke Yew Hall

12:45

Room 1 MB201
Session Chairs
Yangwei Liu + Xiaochen Mao

[TAACF-048] Effect of Front Little Vane on Performance of Highly Loaded Compressor Cascade
→ Hanlin Feng
→ Bo Liu
→ Xiaochen Mao
→ Yingchen Jiao
Northwestern Polytechnical University, China

Room 2 MB217
Session Chairs
Baotong Wang + Qiang Liu

[TAACF-022] Impact of Aerodynamic Loads on Compressor Blade Deformation and Performance
→ Yi Li
→ Xiuxuan Huang
→ Shennen Xu
→ Qian Zhang
Northwestern Polytechnical University, China

Room 3 MB167
Session Chairs
Fanzhou Zhao + Fabian Klausmann

[SMAD-008] Performance Optimization for Pinwheel and Savonius Drag-Dominant Tidal Turbine Using Moment Balancing Method
→ Yixiao Zhang
→ Shivansh Mittal
→ Yin Kwee Ng
Nanyang Technological University, Singapore

Room 4 MB103
Session Chairs
Hengjie Guo + Tengyu Liu

[CC-208] A Dynamic Combustion Model for Supersonic Turbulent Flames
→ Xu Zhu
→ Jian An
→ Nana Wang
→ Jian Zhang
→ Zhuolin Ren
Tsinghua University, China

Room 5 MB237
Session Chairs
Xinrong Su + Michael Pekris

[HTIC-068] Comparison of various schemes of internal cooling channel inside outer ring of ball bearing used in aero-engine
→ Yajun Lu
→ Wenjun Gao
→ Manyuan Li
→ Zhenxia Liu
Northwestern Polytechnical University, China

Room 6 MB141
Session Chairs
Joachim Kurzke + Xiaodong Ren

[TCPP-197] Direct Multi-Fidelity Integration of 3D CFD Models in a Gas Turbine with Fully Coupled Zooming Method
→ Weimin Deng
→ Zuojun Wei
→ Ming Ni
→ Haotian Gao
→ Guangming Ren
Southern University of Science and Technology, China

13:25
Tuesday, October 17th

[13:30] [TAAFC-191] Judgment and Experimental Verification of Blade Tip Leakage Vortex Breakdown
  → Kun Qian
  → Yanhui Wu
  Northwestern Polytechnical University, China

[13:30] [TAAFC-053] Calibration and Sensitivity Analysis of Parameters for Compressor Cascade Flow Field based on Deep Learning and l1 Regularization
  → Tantao Liu
  → Limin Gao
  → Ruiyu Li
  → Lei Zhao
  Northwestern Polytechnical University, China

  → Yuxuan Zhang
  → Dong Yang
  Northwestern Polytechnical University, China

[13:30] [CC-172] The Effect of Temperature Differences on the Acoustic Performance of Helmholtz Resonators
  → Zhenpeng Gan
  → Dong Yang
  Southern University of Science and Technology, China

  → Ping Dong
  → Tao Li
  → Yuxuan Zhang
  → Rui Han
  → Zijie Yu
  → Xu Zhou
  1 Harbin Engineering University, China
  2 Harbin Ship Boiler Turbine Research Institute, China

  → Wangzhi Zou
  → Zhaoyun Song
  → Baotong Wang
  → Mengyang Wen
  → Xiniqin Zheng
  Tsinghua University, China

[14:15] [TAAFC-192] Effect of Fluid Oscillators in Controlling the Corner Separation in a High-load Compressor Cascade
  → Zonghao Yang
  → Xiaochen Mao
  → Bo Liu
  → Botao Zhang
  → Hejian Wang
  Northwestern Polytechnical University, China

  → Zhonggang Fan
  → Chen Yang
  → Dun Ba
  → Juan Du
  → Jichao Li
  Chinese Academy of Sciences, China

[14:15] [TADAM-124] Implementation of a Newton-Krylov Algorithm in the Open-source Solver PHengLEI
  → Sen Zhang
  → Boqian Wang
  → Hongbing Pu
  → Shenren Xu
  → Yong Zhang
  → Xiuxuan Huang
  → Dingxi Wang
  1 Northwestern Polytechnical University, China
  2 Xi'an Jiaotong University, China

  → Tao Yang
  → Yuan Ma
  → Peng Zhang
  Hong Kong Polytechnic University, China

[14:15] [HTIC-113] Conjugate Heat Transfer Characteristics of Narrow Channels in Double-Wall Cooling System with Variable-Size Pin Fins and Film Holes
  → Yi Wang
  → Xiangyu Wang
  → Qingsong Hu
  → Zhenping Feng
  Xian Jiaotong University, China

[14:45] Room: Loke Yew Hall

Plenary Keynote
Speaker: Yasushi Hashimoto (Japanese Aero Engines Corporation (JAEC), Japan)
Title: Sustainable Aviation Fuel: Prospects and Challenges
Session Chair: Prof. Budimir Rosic (University of Oxford, UK)

[14:45] Coffee Break @ Convocation Room 218 and Loke Yew Hall
Tuesday, October 17th

Room 1
MB201
Session Chairs
Xiaochen Mao + Yangwei Liu

Room 2
MB217
Session Chairs
Yingxue Chen + Michael Pekris

Room 3
MB167
Session Chairs
Fanzhou Zhao + Fabian Klausmann

Room 4
MB103
Session Chairs
Tengyu Liu + Hengjie Guo

Room 5
MB237
Session Chairs
Sergey Karabasov + Atsushi Tateishi

Room 6
MB141
Session Chair
Yasushi Hashimoto

[TAAFC-011] The Impact of Variable Fillets on Corner Separation in a Liner Compressor Cascade
→ Gangduo Zhang
→ Mingmin Zhu
→ Runzhu Shao
→ Jinfang Teng
Shanghai Jiao Tong University, China

[ICTMD-099] An Improved Fitting-Base Keyphasor-Free Blade Tip Timing Method and Experimental Validation
→ Yiming Meng
→ Zhicheng Xiao
→ Shang Wang
→ Pengfei Chai
→ Hua Ouyang
Northwestern Polytechnical University, China

→ Boqian Wang
→ Dingxi Wang
→ Xiuxuan Huang
Northwestern Polytechnical University, China

[307 (Invited)] Towards Understanding Thermodynamic Effects on Fuel Injection Process: From Flash Boiling to Transcritical Jets
→ Hengjie Guo
Southern University of Science and Technology, China

[AN-093] Sound Generation by Entropy Perturbations Passing Through Circular Orifices
→ Hanzhuo Zhang
→ Yang Dong
Southern University of Science and Technology, China

[TUADAM-182] Unsteady Flow Phenomenon in the TUDa-GLR-OpenStage Compressor: URANS Observations
→ Hefang Deng
→ Xia He
→ Mingmin Zhu
→ Fabian Klausmann
→ Jinfang Teng
Shanghai Jiao Tong University, China

[CC-216] Effects of Strain Rate on Partially Premixed Flames Under Transcritical Conditions
→ Ziting Lv
→ Wang Han
→ Lijun Yang
Beihang University, China

→ Hussain Ali Abid
→ A.P. Markesteijn
→ Sergey Karabasov
→ Hasan Kamliya Jawahar
→ Mahdi Azarpeyvand
1 University of London, UK
2 University of Bristol, UK

→ Yashan Lin
→ Molly Meng-Jung Li
→ Zhengtong Li
→ Zijian Zhang
→ Chih-Yung Wen
The Hong Kong Polytechnic University, China
Tuesday, October 17th

Room 1: MB201

[TAAFC-301] Investigation of the Controlling Mechanisms of Blade Slotting Technology on the Shock-Wave-Induced Corner Separation
→ Hejian Wang
→ Bo Liu
→ Xiaochen Mao
→ Botao Zhang
→ Zonghao Yang
Northwestern Polytechnical University, China

Room 2: MB217

[ICTMD-184] Multi-Point Map Modification for Aero-Engine Performance Matching Using Adaptation Factor Surface
→ Ye Wang
→ Yongjun Zhao
→ Xichen Wang
→ Zepeng Wang
→ Bokun Zhao
Fudan University, China

Room 3: MB167

[TUADAM-015] Blade Excitation Related Flow Behavior Analysis on the Turbocharger’s Centrifugal Compressor with Volute and Casing Treatment
→ Xuedong Zheng
→ Baotong Wang
→ Chunxiang Yan
→ Xingnan Zheng
Tsinghua University, China

Room 4: MB103

→ Yanqing Cui
→ Haifeng Liu
→ Mingsheng Wen
→ Zhenyang Ming
→ Zunqing Zheng
→ Mingfa Yao
Tianjin University, China

Room 5: MB237

→ Liangli Zhang
→ Hong Tang
→ Jianxin Lian
→ Weijie Chen
→ Weiyang Qiao
Northwestern Polytechnical University, China

Room 6: MB141

[ETR-179] Comparison of Staged and Biphasic Organosolv Pretreatment to Facilitate the Production of Lignin Based Sustainable Aviation Fuel (SAF) from Pelletized Urban Wood Product Wastes
→ Aamir Khan
→ Jianyu Guan
→ Shazia Rehman
→ Song Cheng
→ Shao-Yuan Leu
The Hong Kong Polytechnic University, China

16:40

→ Xindi Wei
→ Yumeng Tang
→ Jiexuan Hou
→ Yangwei Liu
Beihang University, China

17:05

[ICTMD-240] Flow Disturbance by Intrusive Instrumentation Located on the Surface of a Compressor Blade
→ Daniel Jung
→ Lukas Schäfelein
→ Peter Jeschke
→ Roland Wunderer
1 RWTH Aachen University, Germany
2 MTU Aero Engines AG, Germany

17:30

[TAAFC-245] Decarboxylation of High-Temperature Endothermic Chemical Reaction Processes Using a Novel Turbomachine: Robustness of the Concept to Feed Variability
→ Dylan Rubini
→ Nikolos Karyfyllidis
→ Budimir Rodic
→ Liping Xu
→ Elina Nauha
1 University of Oxford, UK
2 University of Cambridge, UK
3 Coolbrook, Finland

→ Jiasen Xu
→ Fangyuan Lou
1 Nanjing University of Aeronautics and Aeronautics, China
2 Tsinghua University, China

[CC-202] Effects of strain rate and equivalence ratio on entropy generation in laminar premixed counterflow flames
→ Silu Xue
→ Wang Han
→ Lijun Yang
Beihang University, China

[CC-204] Subspace and Optimization using Active Learning Methods
→ Jiasen Xu
→ Bing Ge
1 Nanjing University of Aeronautics and Aeronautics, China
2 Tsinghua University, China
武汉工程大学创建于1972年，原化工部主管高校。1998年实行中央与地方共建，以湖北省管理为主。2006年更名为武汉工程大学。学校是一所以工为主的多科性教学研究型大学，是湖北省“一流学科”建设高校。

学校现有在职教职工2255人，有引进院士2人，国家杰出青年科学基金获得者2人。现有博士、硕士研究生6000余人、本科生20000余人、留学生300余人。在US News 2023世界大学排行榜中，世界排名第935位，位列中国内地高校98名。

拥有1个国家磷资源开发利用工程技术研究中心、1个湖北三峡实验室、1个磷资源开发利用教育部工程研究中心，1个国家技术转移示范机构，1个绿色化工过程教育部重点实验室和70个省市级重点实验室等科研平台。

2012年以来，学校承担国家973计划、国家863计划、国家科技支撑计划、国家重点研发计划等国家级项目469项，获国家科技进步奖、国家技术发明奖、国家教学成果奖等各类奖项222项。

粉煤气化及热解重大装备自动振打除灰装置
在国家能源集团、AP公司、中国华能等23家企业应用，市场应用率超90%，属“国家洁净煤发电示范工程”的关键装备。

高性能固液分离技术及成套装备
高性能碳化硅陶瓷膜制备成套技术作价2128万元，入股湖北迪洁膜科技有限责任公司，获湖北省专利金奖。
<table>
<thead>
<tr>
<th>Time</th>
<th>Event</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tuesday, October 17th</strong></td>
<td></td>
</tr>
<tr>
<td>18:00</td>
<td><strong>Opening Reception @ Loke Yew Hall</strong></td>
</tr>
<tr>
<td>19:30</td>
<td>Dinner “Women in Power and Propulsion Sectors” (event organizer: Prof. Juan Du)</td>
</tr>
<tr>
<td><strong>Wednesday, October 18th</strong></td>
<td></td>
</tr>
<tr>
<td>08:15</td>
<td>Author briefing @ Located in each presentation room</td>
</tr>
<tr>
<td>09:00</td>
<td><strong>Northwestern Polytechnical University: Presentation</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker: Prof. Zhiwu Wang (Northwestern Polytechnical University, China)</td>
</tr>
<tr>
<td></td>
<td>Title: Welcome Message from and Introduction to NPU</td>
</tr>
<tr>
<td>09:15</td>
<td><strong>Turbomachinery Lab (TAMU): Presentation</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker: Greg Gammon (Texas A&amp;M Turbomachinery Laboratory, USA)</td>
</tr>
<tr>
<td></td>
<td>Title: Texas A&amp;M Turbomachinery Laboratory Research and Workforce Development Overview</td>
</tr>
<tr>
<td>09:35</td>
<td><strong>Keynotes &amp; Forum on Advanced Computing</strong></td>
</tr>
<tr>
<td></td>
<td>Speaker: Prof. Xiaomo Jiang (Dalian University of Technology and State Key Lab of Structural Analysis, China)</td>
</tr>
<tr>
<td></td>
<td>Title: Status and Challenges of AI-driven Big Model for Smart Maintenance of Turbomachines</td>
</tr>
<tr>
<td></td>
<td>Speaker: Dr. Christopher Savoie (Zapata AI, USA)</td>
</tr>
<tr>
<td></td>
<td>Title: Revolutionizing Energy Applications with Advanced Compute Virtual Presentation</td>
</tr>
<tr>
<td></td>
<td>Session Chair: Prof. Kun Xu (The Hong Kong University of Science and Technology, China)</td>
</tr>
</tbody>
</table>
Youyi campus: 127 West Youyi Road, Beilin District, Xi’an, Shaanxi, 710072, P.R.China
Chang’an campus: 1 Dongxiang Road, Chang’an District, Xi’an, Shaanxi, 710129, P.R.China

- Date back to 1938
- A comprehensive and national key university
- Part of the former Project 985 and Project 211
- Part of the national Double-First-Class initiative
- Total campus area of 3.4+ million m² (two major campuses)
- ~37,000 students, ~4,300 faculty members
- 28 academic schools, 17 national key labs/centers

- Annual research funding ~£200 million (among top 10 in China)
- 5 subject clusters are ranked the global top 1% of ESI
- Science and engineering are ranked among the global top 0.1% of ESI
- Collaborating with more than 300 universities, research institutions and enterprises outside of China.

www.nwpu.edu.cn
### Wednesday, October 18th

#### Coffee Break @ Convocation Room 218 and Loke Yew Hall

<table>
<thead>
<tr>
<th>Room 1</th>
<th>MB201</th>
<th>Session Chairs</th>
<th>Hefang Deng + Xu Dong (BUAA)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Room 2</td>
<td>MB217</td>
<td>Session Chairs</td>
<td>Marcel Oettinger</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Nobumichi Fujisawa</td>
</tr>
<tr>
<td>Room 3</td>
<td>MB167</td>
<td>Session Chairs</td>
<td>Xinrong Su + Yanfeng Zhang</td>
</tr>
<tr>
<td>Room 4</td>
<td>MB103</td>
<td>Session Chairs</td>
<td>Guangyu Zhang + Zhiwu Wang</td>
</tr>
<tr>
<td>Room 5</td>
<td>MB237</td>
<td>Session Chairs</td>
<td>Jing Ren + Penghao Duan</td>
</tr>
<tr>
<td>Room 6</td>
<td>MB141</td>
<td>Session Chairs</td>
<td>Xiaodong Ren + Joachim Kurzke</td>
</tr>
</tbody>
</table>

#### 11:25

- **[TAAFC-071]** Spatial Evolution Mechanism of Vortex Structure in the Highly-loaded Helium Compressor Cascade
  - Ke Sun
  - Zhitaqiu Tian
  - Yingqi Fan
  - Huaxue Lu
  - Xiaozhi Kong
  - Jianchi Xin
  - Benli Peng
  - College of Dalian Maritime University, China

- **[TUARSRIS-033]** Bi-Global Stability Analysis of Flow Separation for Two-Dimensional Compressor Cascade
  - Haoyu Ni
  - Dakun Sun
  - Yibo Fang
  - Xiaofeng Sun
  - Beihang University, China

- **[TAARFT-044]** Efficient Assessment of Turbine Blade Performance with Non-uniform Boundary Condition using Adjoint Sensitivity
  - Ke Xin
  - Zhen Zhang
  - Xinrong Su
  - Xin Yuan
  - Tsinghua University, China

- **[CC-038]** Effect of initial momentum boundary layer on the characteristics of supercritical circular jet mixing flow field
  - Minpeng Yuan
  - Yanyan Feng
  - Yong Xiang
  - Cunhai Wang
  - 1 University of Petroleum, China
  - 2 University of Science and Technology Beijing, China

- **[HTIC-056]** Heat transfer characteristics of corrugated wall impingement with crossflow
  - Rysta Ito
  - Satoshi Mizukami
  - Atsuya Sakata
  - Ryosuke Mito
  - Keijiro Saito
  - Satoshi Hada
  - Mitsubishi Heavy Industries, Ltd., Japan

- **[TAAFC-284]** GReTa - An Open-Source Generic Research Turbofan Low-Pressure Compressor Model
  - Natan Zawadzki
  - Artur Szymański
  - Uyioghosa Igie
  - 1 University of Oxford, UK
  - 2 Cranfield University, UK

- **[TUARSRIS-163]** Stability Analysis of the N-bladed System Under Blade-to-Blade Interaction
  - Youngkuk Yoon
  - Seung Jin Song
  - Seoul National University, South Korea

- **[TAARFT-059]** Performance Impact of Profile Error of a Low-Pressure Turbine Casting Blade
  - Zeshuai Chen
  - Wenhao Fu
  - Jiaqi Luo
  - Zhejiang University, China

- **[CC-077]** Fast Flashback Prediction via Turbulent Flame Speed Estimation
  - Xiaoxu Zhang
  - Hua Zhou
  - Jian Zhang
  - Zhuqin Ren
  - Jun Wu
  - Wei Xiao
  - 1 Tsinghua University, Italy
  - 2 AECC Hunan Aviation Powerplant Research Institute, China

- **[HTFC-180]** Transient Thermal Measurement of Adiabatic Cooling Effectiveness in Transonic Channel Flow
  - Wei Zeng
  - Yisu Liu
  - Sining Dai
  - Haiteng Ma
  - Shanghai Jiao Tong University, China

- **[TCPP-303]** Unit Commitment Optimisation of Gas-fired Generation at Black Point Power Station Incorporating the Efficiency, Flexibility, Reliability & Cost
  - Yuk-Hung Mau
  - Danny H.K. Tsang
  - Ki-On Ng
  - 1 CLP Power Hong Kong Limited, Hong Kong
  - 2 Hong Kong University of Science and Technology, China
Wednesday, October 18th

Room 1: MB201
   → Yannik Schulz 1
   → Lukas Sagan 2
   → Joerg R. Seume 1
   → Peter Eilts 2
   1 Leibniz Universität Hannover, Germany
   2 Technische Universität Braunschweig, Germany

Room 2: MB217
[TUARSRIS-097] Analysis on Stall Mechanism of Axial Flow Compressor with Rotating Inlet Distortion by Dynamic Mode Decomposition
   → Jiahui Qu 1
   → Yunhong Zhong 2
   → Yang Liu 1
   → Yijia Zhao 2
   → Min Zhang 1
   → Juan Du 1
   1 Chinese Academy of Sciences, China
   2 Tianjin University, China

Room 3: MB167
[TAARFT-101] Numerical Study on Loss Evolution Mechanism of Linear Cascade with Leading Edge Cooling Holes
   → Chi Ju Jiang
   → Wei Hao Zhang
   → Rui Feng Zhang
   → Chao Le
   → Yong Jian Wu
   Beihang University, China

Room 4: MB103
   → Ning Jing Yang
   → Yan Xiong
   → Zhi Gang Liu
   → Yan Liu
   → Yuan Lu
   Institute of Engineering Thermophysics, Chinese Academy of Sciences, China

Room 5: MB237
[HTIC-263] Experimental Investigation on the Effect of Impingement Hole Location on Vane Impingement/Film Cooling
   → Xiang Cheng
   → Yu-Zhong Ding
   → Hong-Niu Wan
   → Wen-Tao Ji
   → Ya-Ling He
   → Wen-Quan Tao
   Xi’an Jiaotong University, China

Room 6: MB141

Lunch Break @ Loke Yew Hall

Room 1 MB201
Session Chair: Budimir Rosic

Room 2 MB217
Session Chair: Mehdi Vahdati

Room 3 MB167
Session Chair: Xiaomo Jiang

Technical Keynote: 1
Speaker: Prof. Wei Fan (Northwestern Polytechnical University, China)
Title: The Research and Development of Detonation-based Engines

Technical Keynote: 2
Speaker: Prof. Juan Du (Chinese Academy of Sciences, China)
Title: Stall Margin Improvement on Axial Compressors: Integrated Design of Axial Slot Casing Treatment and Blades

Technical Keynote: 3
Speaker: Shan-Tung Tu (East China University of Science and Technology, China)
Title: Structural Integrity for Greener Power
Energy Equipment Product Portfolio

- Key products of Energy Equipment Unit

Industrial Compressor

Utility Air
A solution to supply compressed air to industrial facilities and equipment (Turbo/Screw)

Oil & Gas
Compressors applied API codes on and design compressors to API 672 and API 617, including oil systems to API614

Process Gas
Gas compressors used for various processes in oil & gas industries (Turbo/Screw)

Fuel Gas Boosting
A gas compressor supplies natural gas as a fuel into gas turbine for generation (Turbo/Screw)

Air Separation
Various manufacturing processes require oxygen, nitrogen and argon gases from air separation, and compressors are used in the process to produce the purified products

Innovative Power Generation System

Supercritical CO₂ Power System
An innovative power generation solution with high efficiency and small footprint compared to conventional steam turbine

Hydrogen Gas Turbine Solution
- Retrofit combustion systems
- Gas turbine life time extension
- Industry-record 60% H₂ fuel blend
- Single-digit NOₓ emissions
Wednesday, October 18th

Room 1
MB201
Session Chairs
Xu Dong (BUAA) + Hefang Deng

Room 2
MB217
Session Chairs
Gangduo Zhang + Juan Du

Room 3
MB167
Session Chairs
Roque Corral + Giovanni Delibra

Room 4
MB103
Session Chair
Hengjie Guo

Room 5
MB237
Session Chairs
Shenren Xu + Fabian Klausmann

Room 6
MB141
Session Chair
Xiaodong Ren + Yongjun Zhao

[TAAF-047] Effects of Increased Tip Clearance on the Unsteady Flow Behaviors at Near-stall Condition in a Counter-rotating Axial Flow Compressor Based on POD Method
→ Ruichen Zhang
→ Bo Liu
→ Xiaochen Mao
→ Ruichen Zhang
→ Bo Liu
Northwestern Polytechnical University, China

[TAAFC-109] Research on the First Stall Stage of the Counter-rotating Axial-flow Compressor under a Large Tip Clearance and Speed Ratio Effects
→ Min Li
→ Xiaochen Mao
→ Ruichen Zhang
→ Bo Liu
Northwestern Polytechnical University, China

[TAFR-135] Variable Stator Vane Forced Response Analysis with Multiple Nodal Diameter Excitations from a Non-adjacent Upstream Blade Row
→ Dongming Cao 1
→ Hongbing Pu 1
→ Yan Qiang 2
→ Jinzhang Feng 2
→ Huang Huang 1
→ Dingxi Wang 1
1 Northwestern Polytechnical University, China
2 AECC Commercial Aircraft Engine Co., Ltd, China

→ Can Wang
→ Haifeng Liu
→ Hu Wang
→ Mingfa Yao
→ Chao Jin
Tianjin University, China

[TADAM-010] Assessment of a Body Force Modeling Approach to Examine the Aerodynamics of High Bypass ratio Fan Stages
→ Jonas Grubert
→ Jens Friedrichs
→ Jan Göing
Technische Universität Braunschweig, Germany

[TCPP-223] Modelling the Nonlinear System Performance of Hybrid-electric Turbofan Engine with Aerothermodynamic Interdependencies
→ Jan Goering
→ Lucas Hanisch
→ Sebastian Lück
→ Markus Henke
→ Jens Friedrichs
Technische Universität Braunschweig, Germany

[TAAF-238 (Invited)] Modelling Practices for Axial Compressors - Assessment of Contemporary Enhancements of k-omega Shear Stress Transport Turbulence Model
→ Natan Zawadzki 1
→ Artur Szymański 2
→ Uyioghosa Igie 2
1 University of Oxford, UK
2 Cranfield University, UK

[TAAF-110] Effect of Circumferential Groove Casing Treatment on Flow Unsteadiness of a Transonic Compressor
→ Guangyao An
→ Jiacheng Kang
→ Jinhua Lang
→ Lei Zhang
→ Hongyang Li
North China Electric Power University, China

→ Hangkong Wu
→ Dingxi Wang
→ Xiaquan Huang
Northwestern Polytechnical University, China

[CC-261] Tomographic Particle Image Velocimetry Measurement on Three-dimensional Swirling Flow in a Swirl Cup
→ Yuyang Zhou 1
→ Sihan Wang 1
→ Dong Lin 2
→ Akira Rinoshika 3
1 Beihang University, China
2 Shanghai University of Engineering Science, China
3 Yamagata University, China

→ Milan Banjac
→ Djordje Petkovic
→ Teodora Madzar
→ Milan Petrovic
University of Belgrade, Serbia

[CC-176] An Enhanced Compressor Map Extension Method Suited for Spool Speeds Down to 1%
→ Joachim Kurzke
Kurzke Consulting, Germany
Coffee Break @ Convocation Room 218 and Loke Yew Hall

Room: Loke Yew Hall

Plenary Keynote

Speaker: Prof. Kun Xu (The Hong Kong University of Science and Technology, China)

Title: Compact High-order Algorithms for Simulation in Turbomachinery with Sliding Mesh

Session Chair: Prof. Mehdi Vahdati (Imperial College London, UK)
### Wednesday, October 18th

<table>
<thead>
<tr>
<th>Room 1</th>
<th>MB201</th>
<th>Session Chairs</th>
<th>Fabian Klausmann + Fanzhou Zhao</th>
</tr>
</thead>
</table>
|       |       |                | [TANV-198] The Effect of Intentional Mistuning on a High Pressure Compressor Blisk Rotor | Jingjie Yang 1  
|       |       |                |                                 | Beirow Bernd 1  
|       |       |                |                                 | Thomas Giersch 2  
|       |       |                |                                 | Bernd Becker 2  
|       |       |                |                                 | 1 Brandenburg University of Technology, Germany  
|       |       |                |                                 | 2 Rolls-Royce Deutschland Ltd & Co KG, Germany |
| Room 2 | MB217 | Session Chairs | Xinrong Su + Yanfeng Zhang |
|       |       |                | [TAAF-020] Effect of Adjustable Vane Partial Actual Clearance on Flow Interaction in a 1.5-Stage Variable-Geometry Turbine | Dongchen Huo  
|       |       |                |                                 | Jie Gao  
|       |       |                |                                 | Lei Wu  
|       |       |                |                                 | Jing Zhang  
|       |       |                |                                 | Harbin Engineering University, China |
| Room 3 | MB167 | Session Chairs | Xu Dong(IET) + Marcel Oettinger |
|       |       |                | [TAF-090] Effects of Inlet Distortion on Aerodynamic Stability of a Transonic Fan | Yun Zheng  
|       |       |                |                                 | Penghui Guo  
|       |       |                |                                 | Hui Yang  
|       |       |                |                                 | Kang Xu  
|       |       |                | Beijing University of Aeronautics and Astronautics, China |
| Room 4 | MB103 | Session Chairs | Min Yao + Haiteng Ma |
|       |       |                | [312 (Invited)] Physics Based Prediction Models for Cooling Jets | Xinrong Su  
|       |       |                |                                 | Tsinghua University, China |
| Room 5 | MB237 | Session Chair | Seung Jin Song |
|       |       |                |                                 | Pengfei Zhu  
|       |       |                |                                 | Jianfang Liu  
|       |       |                |                                 | Shuo Zhang  
|       |       |                |                                 | Zhenxia Liu  
|       |       |                | Shanghai Jiao Tong University, China |
| Room 6 | MB141 | Session Chairs | Michael Pekris + Yingxue Chen |
|       |       |                | [ICTM-031] A High Efficiency Algorithm for Light-Field Multispectral Radiation Thermometry | Chunhui Yao  
|       |       |                |                                 | Hua Fang  
|       |       |                |                                 | Shengxian Shi  
|       |       |                | Shanghai Jiao Tong University, China |

### GPPS University Members

GPPS University / Not-for-Profit Research Institution Membership Program

- Duke University
- ETH Zürich
- The Ohio State University
- TU Delft
- Seoul National University
**Wednesday, October 18th**

<table>
<thead>
<tr>
<th>Room 1: MB201</th>
<th>Room 2: MB217</th>
<th>Room 3: MB167</th>
<th>Room 4: MB103</th>
<th>Room 5: MB237</th>
<th>Room 6: MB141</th>
</tr>
</thead>
<tbody>
<tr>
<td>→ Yucheng Zhang</td>
<td>→ Yufan Wang</td>
<td>→ Alvaro Escudero</td>
<td>→ Xiaopo Wei 1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>→ Shixi Yang</td>
<td>→ Weihao Zhang</td>
<td>→ Roque Corral</td>
<td>→ Yan Xiong 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>→ Jun He</td>
<td>→ Kailai Chen</td>
<td>→ Yago Blando</td>
<td>→ Zhigang Liu 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zhejiang University, China</td>
<td>→ Dongming Huang</td>
<td></td>
<td>→ Fan Li 2</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>→ Hui Wang 1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Cruise Pickup at 18:10 @ Infront of Main Building

Harbour Cruise and Event Dinner (19:00-21:00)

Following the event, attendees will make their own travel arrangements to hotels direct from the central pier by walking to the nearby central metro station or buses running from the pier area.

---

**GPPS Technical Conference 24**

**Doha, Qatar 2024**

The Global Power and Propulsion Society Technical Conference is to be held in Doha, Qatar in October 2024.

Collaborating with the Turbomachinery Laboratory we expect the conference to be an event to remember.

Join us in Qatar to see the latest high quality research projects. For more information regarding GPPS Doha24 visit: www.gpps.global/gpps-doha24.html
Realize your dreams

Space

Defense System

Civil Aircraft Engines

IHI

IHI Corporation  Aero Engine, Space & Defense Business Area/IHI AEROSPACE Co., Ltd.
**Thursday, October 19th**

**Author briefing @ Located in each presentation room**

<table>
<thead>
<tr>
<th>Room 1</th>
<th>MB201</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Session Chairs</strong></td>
<td>Michael Pekris + Huawei Lu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Room 2</th>
<th>MB217</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Session Chairs</strong></td>
<td>Marcel Oettinger + Haoyu Ni</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Room 3</th>
<th>MB167</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Session Chairs</strong></td>
<td>Hiroshi Kuroki + Zijian Wang</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Room 4</th>
<th>MB103</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Session Chairs</strong></td>
<td>Wenwu Zhou + Hangkong Wu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Room 5</th>
<th>MB237</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Session Chairs</strong></td>
<td>Nobumichi Fujisawa + Wenqiang Zhang</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Room 6</th>
<th>MB141</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Session Chairs</strong></td>
<td>Penghao Duan + Jing Ren</td>
</tr>
</tbody>
</table>

**[TARMFC-066]**
Design and Construction of Rotor–Stator Disk Cavity with Radial Inflow
→ Xin Shen
→ Jun Liu
→ Qiang Du
→ Liu Guang
→ Zeng Yan Lian
→ Ran Ren

1 Jiangsu University, China
2 Chinese Academy of Sciences, China

**[TUABRIID-100]**
Full Annulus Simulation on a Multistage Axial-Centrifugal Combined Compressor
→ Cheng Tian
→ Song Fu
Tsinghua University, China

**[309 (Invited)]**
Evolution of Creep-Ratcheting and Lifetime Prediction of Advanced 9-12% Cr Ferritic Steel at 600 °C
→ Xiao-Tao Zheng
Northwestern Polytechnical University, China

**[304 (Invited)]**
Oil-air two phase flow inside cylindrical roller bearings with under-race lubrication
→ Wenjun Gao
Tsinghua University, China

**[TUARSRIS-018]**
Flow Physics During Surge of an Axial-Centrifugal Compressor
→ Jiaan Li
→ Weihan Kong
→ Xueqi Zou
→ Xiwu Liu
→ Baotong Wang
→ Xinqian Zheng
Tsinghua University, China

**[SMDAM-037]**
Layout Optimization of Constrained Damping Material for Composite Fan Blade
→ Zijian Wang
→ Yong Chen
→ Jiguang Zhang
→ Xu Tang
→ Lu Jin
→ Enbo Sun
→ Haihong Zhang
→ Yuxiang Wu
→ Shanzhen Li
→ Yuhan Long
→ Lifu Zhang

1 Xi’an Jiaotong University, China
2 Airforce Engineering University, China

**[DEFIGT-094]**
Particulate Deposition Effects in Film Cooling Holes
→ Zihan Hao
→ Xing Yang
→ Zhenping Feng
→ Xian Jiaotong University, China

**[TUARSRIS-029]**
The Effects of Reynolds Number on the Instability Boundary and Dynamic Characteristic of an Axial-Centrifugal Combined Compressor
→ Weihan Kong
→ Jiaan Li
→ Baotong Wang
→ Xinqian Zheng
→ Tsinghua University, China

**[HTDAM-085]**
Numerical study on the influence of different bending curvature on the heat transfer characteristics of annular cross wavy primary surface recuperator (CW-PSR)
→ Huadong Jiang
→ Fu Chen
→ Jiansong Yu
→ Yanping Song
Harbin Institute of Technology, China

**[TARMFC-130]**
Numerical Study of the Reynolds Number on the Energy Losses Inside Centrifugal Compressor
→ Zi Liang Li
→ Xingwen Lu
→ Ge Han
→ Lin Li
Chinese Academy of Sciences, China

**[TUABRIID-117]**
Adjusting the Ratio of Steady and Dynamic Components of Total Pressure Distortion Using the Combination of Annular Plate and Cylindrical Rod
→ Enbo Sun
→ Haihong Zhang
→ Yun Wu
→ Shanzhen Li
→ Yuhan Long
→ Lifu Zhang

1 Xi’an Jiaotong University, China
2 Airforce Engineering University, China

**[SMDAM-037]**
Layout Optimization of Constrained Damping Material for Composite Fan Blade
→ Zijian Wang
→ Yong Chen
→ Jiguang Zhang
→ Xu Tang
→ Enbo Sun
→ Haihong Zhang
→ Yun Wu
→ Shanzhen Li
→ Yuhan Long
→ Lifu Zhang

1 Xi’an Jiaotong University, China
2 Airforce Engineering University, China

**[DEFIGT-094]**
Particulate Deposition Effects in Film Cooling Holes
→ Zihan Hao
→ Xing Yang
→ Zhenping Feng
→ Xian Jiaotong University, China

**[TUARSRIS-029]**
The Effects of Reynolds Number on the Instability Boundary and Dynamic Characteristic of an Axial-Centrifugal Combined Compressor
→ Weihan Kong
→ Jiaan Li
→ Baotong Wang
→ Xinqian Zheng
→ Tsinghua University, China

**[HTDAM-167]**
A Mean-Fluctuation Decomposition Scheme to Accelerate the Simulation of Unsteady Conjugate Heat Transfer
→ Feixue Cai
→ Hua Zhou
→ Min Yao
→ Zhiyin Ren
Tsinghua University, China
Thursday, October 19th

Room 1: MB201

[TARMFC-153] Study of a High-Pressure Ratio Centrifugal Compressor With a Wedge Diffuser and a Pipe Diffuser
→ Junnan Liu
→ Xiuquan Huang
Northwestern Polytechnical University, China

Room 2: MB217

[TAEDAM-075] Static Aeroelastic Analysis of Rotor Blades Based on a Fast Two-Way Fluid-Structure Interaction Method
→ Jiaxing Li
→ Jiaqi Luo
Zhejiang University, China

Room 3: MB167

[SMDAM-276] Nonlinear Frequency Response Analysis of a Rotating Structure via the Hyper-reduction
→ Seung-Hoon Kang 1
→ Sangmin Lee 2
→ Minho Hwang 1
→ Yongse Kim 1
→ Haeseong Cho 1
→ SangJun Shin 1
1 Seoul National University, South Korea
2 Republic of Korea Air Force, South Korea
3 Jeonbuk National University, South Korea

Room 4: MB103

[DEFICT-115] Impact Force of Ellipsoidal Droplets on Superhydrophobic Surfaces
→ Saroj Ray
→ Song Cheng
The Hong Kong Polytechnic University, China

Room 5: MB237

[TUARSRIS-054] Dynamic Mode Decomposition for the Tip Unsteady Flow Analysis in a Counter-Rotating Axial Compressor
→ Yanchao Guo
→ Limin Gao
→ Xiaochen Mao
→ Chi Ma a
→ Guanzhong Ma
Northwestern Polytechnical University, China

Room 6: MB141

[HTDAM-194] 1D Analytic and Numerical Analysis of Thin Film Heat Transfer gauges and Infra-red Cameras in Non-planar Applications
→ Mark Baker
→ Budimir Rosic
University of Oxford, UK

→ Yibing Xu
→ Lei Gao
→ Chong Yan
→ Ruizhe Cao
→ Qujun Wang
→ Ying Piao
Tsinghua University, China

[TAEDAM-244] Validation of Helicity-Corrected Spalart-Allmaras Model for Corner Separation Prediction in Incompressible Flow with OpenFOAM
→ Xin Jing
→ Fang Zeng
Northwestern Polytechnical University, China

[DEFIGT-021] Experimental study of Particle Depositions on Flat Plate with Sweeping Jet
→ Tianlun Zhang
→ Weichen Huang
→ Kechen Wang
→ Wenwu Zhou
→ Yingzheng Liu
→ Wei Tian
Shanghai Jiao Tong University, China

[DEFIGT-221] Experimental Study on Time-Frequency Characteristics of Rotating Instability in an Isolated Axial Compressor Rotor with Variable Clearance
→ Fan Yang
→ Yanhui Wu
Shanghai Jiao Tong University, China

[DEFIGT-298] Meso-scale Investigation on the Deformation and Failure Behaviors of Plain Woven SiC/SiC with Holes
→ ZhiFan Yu
→ Jeff Defoe
University of Windsor, Canada

[DEFIGT-077] Experimental Study on Time-Frequency Characteristics of Rotating Instability in an Isolated Axial Compressor Rotor with Variable Clearance
→ Tianlun Zhang
→ Weichen Huang
→ Kechen Wang
→ Wenwu Zhou
→ Yingzheng Liu
→ Wei Tian
Shanghai Jiao Tong University, China

[HTDAM-104] Uncertainty Quantification Analysis on Heat Transfer Characteristics of Inclined Jets Impinging on the Cylindrical Surface in the Confined Space
→ lei Shi 1
→ yan Li 2
→ xiaocheng Zhu 3
→ Zhaohui Du 1
1 Shanghai Jiao Tong University, China
2 China United Gas Turbine Technology Co., LTD., China

Coffee Break @ Convocation Room 218 and Loke Yew Hall
Thursday, October 19th

Room 1 MB201
Session Chairs
Shenren Xu + Fabian Klausmann

Room 2 MB217
Session Chairs
Juan Du + Gangduo Zhang

Room 3 MB167
Session Chairs
Zijian Wang + Hiroshi Kuroki

Room 4 MB103
Session Chairs
Zhiwu Wang + Guangyu Zhang

Room 5 MB237
Session Chairs
Qiang Liu + Giovanni Delibra

Room 6 MB141
Session Chairs
Haiteng Ma + Min Yao

[TADAM-077] An Automatic Mesh Generation System for Aeroengine Blade Design and Optimization
→ Jiazheng Fan 1
→ Yongxiang Wu 2
→ Chuan Han 3
→ Wei Hong Li 1
→ Penghao Duan 1
1 City University of Hong Kong, China
2 University of Stuttgart, Germany
3 Suzhou Nuflux Technology Co., Ltd, China

[TAAFC-068] Investigation of Complicated Flow Near the Blade Tip of a Compressor Tandem Cascade Using DDES
→ Botao Zhang
→ Bo Liu
→ Xiaochen Mao
→ Zonghao Yang
→ Hejian Wang
Northwestern Polytechnical University, China

[SMSV-072] A Preliminary Evaluation Method For Fan Blade Rubbing Stability Based On Finite Element Analysis
→ Minghui Sun
→ Xu Tang
→ Yong Chen
Shanghai Jiao Tong University, China

[CC-114] Effects of transverse injection distribution scheme on dual flame dynamics subjected to flow disturbances
→ Tengyu Liu 1
→ Pengcheng Wang 2
→ Jingxuan Li 2
→ Lijun Yang 3
→ Zhuyin Ren 1
1 Tsinghua University, China
2 Beihang University, China

[TAFB-226] Leading Edge Bumps for Axial Fan Operating with Inflow Distortion
→ Giovanni Delibra 1
→ Alessandro Corsini 1
→ Lorenzo Tieghi 1
→ Johan van der Spuy 2
1 Sapienza University of Rome, Italy
2 Stellenbosch University, South Africa

[TADAM-122] Application of Surrogates Models Based on CFD Database for Performance Prediction of Transonic Compressors
→ Zichen Han
→ Xiaochen Mao
→ Zijing Chen
→ Bo Liu
Northwestern Polytechnical University, China

[TAAFC-287] Effects of k-omega Shear Stress Transport Turbulence Model Enhancements on Axial Compressor Rotor Performance and Near-stall Operation
→ Artur Szymański 1
→ Natan Zawadzki 2
1 Cranfield University, UK
2 University of Oxford, UK

→ Alex Nakos
→ Bernd Beirig
Brandenburg University of Technology Cottbus, Germany

[TAWT-095] Numerical Simulation of Large Scale Wind Turbine Wake and the Influence on Vibration of Downstream Wind Turbine
→ Chunming Qu 1
→ Desheng Miao 2
→ Sheng Li 1
→ Wen Peng Ge 3
1 Mingyang Smart Energy Group Co., Ltd, China
2 Ocean University of China, China
3 Ocean University of China, China
Company Introduction

Cathay Vista is a high-tech enterprise with its various intellectual properties. Cathay Vista penetrates in clean energy technology, material science technology, industrial waste water treatment technology. With its capabilities in engineering, designing, special equipment production and operational services, is undertaking R&D on SOFC power generation system and SOEC high efficient hydrogen generating system. In order to well adapt and furthermore, well achieve the future Carbon Peak and Carbon Neutrality goals.

Cathay Vista is committed to develop safe, clean, and efficient energy transferring technologies, to better promote the implementation of low carbon emission society.

E-mail: info@cathayvista.com  www.cathayvista.com
Thursday, October 19th

**Room 1**  
MB201  
*Session Chair*  
Liping Xu  

**Technical Keynote: 4**  
*Speaker:*  
Prof. Shijin Shuai  
(Tsinghua University, China)  
*Title:* Development Trend of Low Carbon and Electrification Technologies in Aviation Power

**Room 2**  
MB217  
*Session Chair*  
Dingxi Wang  

**Technical Keynote: 5**  
*Speaker:*  
Prof. Mehdi Vahdati  
(Imperial College London, UK)  
*Title:* Prediction of Aerodynamic and Aeroelastic Instabilities of Fans

**Room 3**  
MB167  
*Session Chair*  
Xiaofeng Sun  

**Technical Keynote: 6**  
*Speaker:*  
Prof. Stephane Moreau  
(Université de Sherbrooke, Canada)  
*Title:* The next age of turbomachinery noise predictions

---

**Coffee Break @ Convocation Room 218 and Loke Yew Hall**

---

**Room: Loke Yew Hall**

**Plenary Keynotes & Forum on Future Energy**

*Speaker:*  
Dr. Ming Li (Chinese Society of Astronautics, China)  
*Title:* The Development and Application of Space Solar Power

*Speaker:*  
Prof. Chin Pan (City University of Hong Kong, China)  
*Title:* Nuclear Power as a Sustainable Energy Option

*Speaker:*  
Dr. Henry Lau (UK Atomic Energy Authority, UK)  
*Title:* Robotics Challenges for Fusion Energy  
*Virtual Presentation*

*Session Chair:*  
Prof. Shan-Tung Tu (East China University of Science and Technology, China)

---

**Room: Loke Yew Hall**

**Closing Ceremony & GPPS Hong Kong23 Student Paper Awards**

**Closing Remarks**  
GPPS Journal & GPPS Hong Kong23 Best Student Paper Awards  
*Session Chair:*  
Prof. Budimir Rosic (University of Oxford, UK)
高端工业仿真软件

西安流固动力科技有限公司基于“产”、“学”、“研”相结合，致力于国产高端工业仿真软件研发、工程项目咨询及专业设备研制的高新技术企业。

核心团队经过数十年的艰苦攻关与大胆创新积累，研发出流体系统仿真软件、涡轮冷却叶片仿真设计软件、多物理场耦合分析软件、传感器仿真设计软件等十余款具有自主知识产权的仿真软件产品。在实现自主可控的同时，关键参数已达到行业先进水平。

目前产品广泛应用于工程仿真设计领域，参与重要型号研制，助力国产高端装备自主开发，合作客户分布于航发、航空、船舶、电子、能源动力等工业领域。

Web: http://www.lgsim.com  Email: support@lgsim.com
华东理工大学机械与动力工程学院秉持科学研究与国家需求相结合的理念，以“引领高端装备源头技术创新，强化安全、绿色、可靠、智能基础理论前沿研究，培养具有创新能力的高水平人才”为定位，致力于培养“提高创新能力、实现重点突破、支撑国家发展、引领科技未来”综合性人才。

承压系统与安全教育部重点实验室于2009年正式开放运行，是目前国内唯一从事承压系统与安全领域基础研究的基地。实验室围绕“安全”、“绿色”、“可靠”和“智能”四个方向，在严苛环境安全保障技术与理论、环境与氢能技术与装备、以可靠性为中心的制造范式以及承压系统智能感知与运维管理等方面，取得了具有重要学术影响以及重大工业应用价值的创新成果。

我们诚邀过程装备领域的专家同行精诚合作，携手奋进！

联系方式：
华东理工大学机械与动力工程学院
上海市徐汇区梅陇路130号
联系电话：021-64252819
E-mail：tangweiyue@ecust.edu.cn
联系人：汤玮悦
The Journal of the Global Power and Propulsion Society is an open access journal, devoted to the advancement of the science and technology of power generation and propulsion systems through the dissemination of original archival papers contributing to advancements in turbomachinery based technologies. The GPPS Journal proudly presents its inaugural scores since its foundation in 2017. It has achieved an impressive Journal Impact Factor (JIF) of 0.9, as recognized by the Web of Science. Simultaneously, it holds a commendable CiteScore of 1.2 according to Scopus. Additionally, the Journal is digitally preserved by the Portico Digital preservation archive. This solidifies the Journal as an exceptional platform to promote your research within the industry and to reach the widest possible audience.